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The PhotoKit 2 User Manual
PhotoKit 2 (PK2) is a photographer’s toolkit comprising 161 effects. Some offer accurate digital replications 

of analog photographic effects: others, such as the sharpening, grain, and noise reduction effects, produce 
results that would be difficult if not impossible to achieve in an analog darkroom. In both cases, PhotoKit 
2’s image enhancements and adjustments are designed to work in a way familiar to photographers. A 
simple dialog calls up the PhotoKit 2’s Toolbox, where you can easily select the desired image effect, and let 
PhotoKit2 do the work.

PK2 is an “Automate Plug-in,” a different breed of plug-ins for Photoshop that allow custom programming 
combined with core functionality of Photoshop itself. As such, PK2 appears under the File menu’s Automate 
sub-menu. After successful installation, PK2 is available whenever you have a 8 or 16 bit/channel RGB 
(24 or 48 bit color) image open. It  will not work on CMYK, Lab or Grayscale images. PK2 will run in 
Photoshop CS3 or above on both Macintosh and Windows platforms and will run in both 32 bit and 64 bit 
applications where supported (Windows Photoshop CS4 and above and Mac Photoshop CS5 and above).

ANALOG EFFECTS TOOLKIT ™

for Adobe® Photoshop®

2.0

The PhotoKit 2 dialog box showing the PixelGenius Toolbox window.

The PhotoKit 2 sub-menu item under the Automate menu in the Photoshop File main menu.
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A - The new dialog window in PK2 now includes a preview button that allows see-
ing a preview of the selected sharpening effect. For some effects, the preview will 
only be accurate when the preview window is zoomed to 100%.

B - The cursor inside of the preview window shows the area of the image that will 
be zoomed in when you click the mouse.

C - New to PK2 (but previously available in PhotoKit Color 2) is the ability to have 
effects with multiple layers and layer groups returned as a single combined pixel 
layer. This feature can help keep file sizes down although it does impact the flexibil-
ity of individual layer adjustments after an effect has been applied.

D - The Create Layer Mask options allow all PK2 effects to be brushed in or out 
depending on the Hide or Show effect options. The Hide Effect returns a layer with 
a layer mask set to black. The Show Effect returns a white layer mask that shows the 
final effect. To paint in an effect with a Hide Effect layer mask, paint with white. To 
remove the effect on a Show Effect layer paint with black.

E - The Show Batch Options allow stacking multiple effects to be run one after the 
other. So, if you use a common capture, creative and output sharpening series, you 
can add those effects to a batch set. The batch set can be saved and loaded. If you 
have multiple PhotoKit brand products you can also mix and match effects across 
products.

F - The Message window explains what the selected Set is intended to be used for.

The basic PhotoKit 2 dialog window showing highlighted new features.

PixelGenius has worked hard to add new features and address previous users’ requests. As a result, we have 
redesigned the user interface (UI) to take advantage of what we call the PixelGenius Toolbox. First introduced 
with the release of PhotoKit Color 2, the PixelGenius Toolbox UI provides for image previews as well as 
additional functionality as shown in the figure below. The red letters highlight the changes and additions.

PhotoKit 2 New Feature Highlights and User Interface
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Using PhotoKit 2 
When you launch PK2 you’ll select from three dropdown menus; Module, Set and Effect. The figure below 

left shows the normal PhotoKit 2 dropdown menus. The figure on the right shows the Module dropdown 
expanded to show various installed PhotoKit brand products. If you only have PhotoKit 2 installed, that will 
be the only Module that is displayed.

Click on the Set dropdown menu to select one of the ten PK2 effects sets (below left). Once the Set is 
selected, click on the Effect dropdown menu to select the effect (below right). The figure at the bottom of the 
page is showing the result of selecting the Yellow Contrast effect. Note the Preview option box is checked.

The PhotoKit 2 dropdown menus with only
PhotoKit 2 installed.

The dropdown menus with PhotoKit 2, PhotoKit 
Color 2 and PhotoKit Sharpener 2 installed.

The Color to B&W set is selected. The Yellow Contrast effect is selected.

With the Preview option box checked, PK2 will show a preview of the selected effect.
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Once you’ve selected the effect you want click on the OK button to apply it to your original image. The 
results will be returned as a new layer as shown in the lower left figure. While the Toolbox window is open 
you can access the PK 2 user manual by clicking on the Help button. You’ll need either Acrobat Reader or 
some other application that can open PDF files. If you click on the Info button, your web browser will launch 
and you’ll go to the PhotoKit 2 Info page on the PixelGenius website. There you can check for updates or 
access additional information about PhotoKit 2.

Using the PixelGenius Toolbox
PhotoKit 2 uses the PixelGenius Toolbox (see the window title) functionality to preview the selected effect. 

Once the Preview option is checked, Toolbox will take your image and apply the selected effect. Changing 
the Module, Set or Effect will cause the Preview to be updated. You can toggle the Preview option on and 
off to see the results of the effect. The figures below show the original image and additional effects being 
previewed. Depending on the effect, the differences may be strong or subtle.

The PixelGenius Toolbox buttons. The result of applying a PK 2 effect on your image.

The Preview unchecked showing the original image. The Preview of the Green Contrast effect.

The Preview of the Red Contrast effect. The Preview of the Yellow Contrast effect.
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Preview Zooming
Most PK 2 effects will show accurate effect previews when the full image is set to fit in the preview window. 

Some effects, however, will not be an accurate representation due to differences in image resolution and the 
impact the PK 2 effect will have at different image resolutions. For those effects we suggest you use the zoom 
tool to zoom into the image at a 100% view (each image pixel will be one screen pixel).

In the figure below you’ll note the warning Preview is only accurate at 100% under the preview window. 
That is because most of the effects in the Detail Enhancement set are resolution dependent. PK 2 runs the 
actual effect on the preview image and as a result, the preview will be inaccurate–generally showing an 
over-effect result. When you move your mouse cursor over the Preview window, the cursor will change to a 
magnifying glass with an outlined box indicating where the 100% zoomed view will display.

Once you click on the preview, Toolbox will render the previewed area at a 100% as shown in the lower left 
figure. The 100% preview will be an accurate representation of the impact the effect will have on your image. 
To zoom back out you simply click again on the image preview. Because PK2’s effects can be complicated 
and processor intensive, we don’t allow scrolling in the zoomed in Preview. However, zooming out of one 
area and zooming back into a new area is fast. We suggest practicing with the zoom function to get the hang 
of using it. Note than when you zoom in the cursor changes to a minus magnifying glass. You can toggle the 
preview on and off to better judge the effect. The image on the lower right has the Preview button unchecked. 
You can also change the effect you wish to preview while zoomed in. This is helpful for choosing a strength 
when effects offer multiple strengths.

The Toolbox window showing the review warning, note the sharpening looks too strong.

The image is zoomed to 100% showing an accurate preview 
of the High Pass Sharpen 2 effect.

The figure above has the Preview option unchecked show-
ing the original image without the effect applied.
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Preview Special Case
While PK2’s effects can be accurately previewed while zoomed into 100%, what they are showing might 

be misleading in a few special cases. The Edge Effects set are an example of effects causing accurate but 
misleading zoomed previews. Below left is the preview showing the Rough White Border-Sharpen effect. 
Below right is the same effect being previewed at 100%. The 100% preview is accurate in terms of the final 
size of the border relative to the image, however the edge effect is being shown going all around the image 
when zoomed to 100%. Obviously, when you run the effect on your image, the border will be around your 
entire image, not the zoomed in portion of the image.

The rough border effects also have an unusual result for PixelGenius products. Each time you run the 
rough border effects you’ll get a unique result. Usually our effects are noted for their consistency but this is 
a special case where each application will result in a slight difference. Sometimes that’s good but if you are 
trying to get the exact same effect on multiple images, we suggest you apply the effect to one image then drag 
and drop the resulting border layer to the other images.

The Create Layer Mask Option

The Create Layer Mask option in the PixelGenius Toolbox allows you to automatically add a layer mask 
set either to Show Effects (white layer mask) or Hide Effects (black layer mask). This allows you to paint in 
or paint out a PK2 effect with a brush. The only functional difference between the options is whether or not 
you want to paint in or out an effect. In the figures below, the left Layers panel shows the result of applying a 
Cooling 4 effect from the Color Correction set with a Show Effect option. The middle figure shows the Hide 
Effect result. The figure on the right shows the result of painting in the layer mask to isolate the effect to the 
center of the image.

The preview above is showing a much wider border effect 
than you’ll end up getting on the full image.

The preview above is showing an accurate border size 
but is incorrectly implying the border will be around 

only a small portion of the image.
 

Layer with Show Effect layer mask. Layer with Hide Effect layer mask. Layer with painted layer mask.
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Show Batch Options

Selecting the Show Batch Options in PK2 provides a solution for applying multiple effects to your image 
from a single dialog. It also allows one to save preset workflows including PhotoKit Color 2 and PkotoKit 
Sharpener 2 effects and easily apply them to similar images. 

The Batch Dialog Options become available once the Show Batch Options checkbox is checked. After the 
first effect is chosen in the Module, Set and Effect,  the effect is added to the Batch Window by clicking the 
Add button. NOTE: the OK and Preview buttons are greyed out (not active) until you add at least one Effect. 
The selected effect will then appear in the Batch Window. Additional effects are then added and will appear 
in the Batch Window. When all desired effects are added, clicking the OK button will run the batch.

The combined effects can be previewed by checking the Preview Button.  To insure a more accurate preview 
click on the Preview window to view a selected portion of the image at 100%.  The figure immediately below 
shows the Show Batch Options checked before adding any effects. Note the OK and Preview buttons are 
disabled.

For this example we’ve chosen to show how to add effects across multiple PG products. This first effect will 
be an Auto Edge Sharpen from the PhotoKit Capture Sharpener 2. The bottom left figure shows the result of 
adding the first effect to the batch list. On the lower right figure we’ve added a PK2 Red Contrast effect from 
the Color to B&W set.            

The PixelGenius Toolbox with the Show Batch Options checked.

The Batch List showing the addition of the first effect. The Batch List showing the addition of the next effect.
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Once you’ve added the various effects to the Batch Set you can preview the results of all the added effects. 
You can’t individually turn single effects previews on or off. The preview will always be the result of all 
accumulated effects. You can, however, delete an effect as shown in the figure below left. Click on the effect 
you wish to delete. When selected, the Delete key becomes active. Click it to delete the effect from the Batch 
List. The order of the effects will remain in the order you added them minus the deleted effect. You can not 
reorder the batch list. If you wish to add an effect in between two effect, the later added effects must first be 
deleted.

While adding effects, you can choose to have a layer mask added for that individual layer. The figure below 
right shows the Create Layer Mask option turned on and the Brown Tone effect indicates that layer’s layer 
mask will be a Show Effect. If you use this option the the checked box is sticky which means the next effect 
you ad will have the same option selected. If you don’t want a mask on the next effect, be sure to deselect the 

option before adding the next effect.
The figure below shows the result of adding a capture sharpening, Red Contrast, Brown Tone and an Inkjet 

Output Sharpener to the Batch Set. If you now click OK, the PG Toolbox will run each effect one after the 
other and return all the effects as individual layers and groups in your original file.

Selecting and deleting an effect from the Batch List. Adding an effect with the Create Layer Mask option.

The final Batch List with effects from PKS2 and PK2.
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The Merge Results Option 

Selecting the Merge Results option will condense down all of the various layers PK 2 may produce into 
a single pixel layer as shown below. In this example, the results of the Batch Set from the previous page  
containing two layer groups and two pixel layers (below left) have been combined into a single PixelGenius 
Toolbox Layer (below right). This can provide considerable file size savings but does limit flexibility because 
the individual layers are combined.

Saving Batch Sets
If you wish to apply the same Batch List to multiple files, you can save the list and reuse it. Once you’ve 

added the effects to the Batch Set (and before hitting the OK button) click on the Save Button as shown in 
the far left figure below. Once you click on the button you’ll see a Save Batch Set dialog (below middle left). 
Enter text in the Set Name text field. If you have existing sets already saved, they will show in the Existing 
Sets field. Once the list set is saved you can run the effect on the current image.

To run the same list set on a new image, open the new image and launch PK2. Once the Toolbox window 
is open (the Batch List option is sticky between launches) click on the Load button (lower middle right). This 
will open the Load/Delete Batch Sets window. Select the Batch Set you want to run–you’ll see what effects are 
in the set once you click on it. You can also delete saved sets using the Delete key. Once you’ve selected the 
set (below far right figure) click OK and the saved Batch Set will appear in the main Toolbox window. Simply 
click the main OK button and the saved Batch Set will run on the new image.

The layers produced by the Batch List.

The layers produced by the Batch 
Set but selecting the option to 
Merge Results. This returns a sin-
gle layer named PixelGenius Tool-
box Layer.

Save Batch set 
button.

The Save Batch Set window. Load Batch Set 
button.

The Load/Delete Batch Sets window.
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Recording Actions using PhotoKit 2
In addition to the batch functionality built into PK2 and the PixelGenius Toolbox, you can also record a 

Photoshop action and use actions to apply PK2 effects. While not intended as a deep demo of Photoshop 
actions, we wanted to outline the basic steps. 

To record an action you’ll need to either create a new action set as we show below or start recording a new 
action in an existing action set. In the figures below we’re starting a new set. In the lower left figure we show 
clicking on the Create new set button. That opens a New Set window as shown below right. We’ve entered 
PG-Batch Actions as the set name.

Once you’ve created a new set, you’ll need to record a new action. Click on the Create new action button 
as shown below left. That will open the New Action window shown below right. Once you click Record, the 
red light on the Actions panel will light up in red as shown on the far right.

Once the action is recording you can run a PK2 action as you normally would. You’ll need to have a 
supported image open. Simply go to the Automate menu and select PhotoKit 2 and run whatever action you 
want to record. As you record an action step it will appear in the Actions panel as shown below left. Below 
right a second action step has been recorded. You can record as many steps as you want and combine steps 
with other functions and filters in Photoshop. Once you’ve finished recording click on the Stop button.

Clicking on the Create new set button.

The New Set window with the set name entered.

Clicking on the Create new action button.

The New Action window with the action name entered.

The action is now recording.

Action steps appear in the Actions panel above.
The figure on the right shows the Stop button
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Using Actions in a Photoshop Batch Process
You can incorporate PK2 actions in a Photoshop Batch process and even apply the actions directly from 

within Bridge. To use an action in a Batch process from Bridge, we suggest recording some additional steps. 
One step is to record saving the file in a specified folder as shown below left. Note we’ve also recorded a Close 
step. This is really important to include in the action because without a close step, Photoshop will continue 
opening, processing and saving the file but leave them open in Photoshop. Not a big problem if you are only 
batch processing a few files but it can be a real problem if you are batching several hundred images. The 
figure below right shows selecting the Batch command from the Bridge Tools menu.

In the Batch window, select the action you want to run in the Play section. In this example we’re going to 
play the Toned B&W action from the PG-Batch Actions set. The source defaults from Bridge. We suggest 
selecting the options to Suppress File Open Options Dialogs option and the Suppress Color Profile Warnings 
as shown below. Since the action has a recorded Save step, we don’t need to select anything in the Destination 
panel. We suggest using this approach when first starting to learn how to use Batch because saving to a new 
location will make sure you don’t overwrite your original file. When set, click OK.

Recording a Save and Close command. Choosing the Batch command from Bridge.

The Photoshop Batch window opened from Bridge.
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Additional Info and Resources:
In addition to this manual, be sure to check out the

PK 2 product page for additional information:
www.pixelgenius.com/photokit2

For product updates and downloads:
www.pixelgenius.com/downloads.html

For Tech Support please use the web form found at:
www.pixelgenius.com/support.html

For information about your order from
eSellerate, our on-line fulfillment provider, please visit:

www.store.esellerate.net/store/support
Credits for PhotoKit 2:

Product Design: Martin Evening, Bruce Fraser, Mac Holbert,
Seth Resnick, Andrew Rodney, Jeff Schewe & Mike Skurski

Product Manager: Jeff Schewe
Specification Manager: Jeff Schewe

Software Architecture: Mike Skurski
Software Engineering: Michael Keppel

PhotoKit 2 is a trademark of Pixel Genius LLC. ©2011-All rights reserved.
www.pixelgenius.com

About PhotoKit 2
To see your serial number for PK 2 or to deactivate your install of PK 2, you can access the About 

PhotoKit 2 splash screen from within Photoshop. On Mac you’ll find it under the Photoshop menu in 
the About Plug-in submenu. On Windows it’s under the Help menu About Plug-in submenu. The splash 
screen is shown below.  

The PK 2 splash screen
(Note: the actual serial number has been obscured).

Thanks to You from the PixelGenius Team.
We hope this manual is helpful to you. We want to thank our users for all their help and support over the 

years–the pleasure has truly been ours. We started PixelGenius with the goal of making useful products 
that we would like to use. We did and we do. But, it is because of the strong support of our user base that 
we created PhotoKit 2 so, to you, we say thanks.

We would also like to thank and remember two former members of PixelGenius who sadly are no longer 
with us. Mike Skurski was the engineer that originally got this merry band of brothers together. His insight 
and dedication allowed us to create simple tools that we wanted to use. We also wish thank and remember 
Bruce Fraser who was the original inspiration, designer and product manager for PhotoKit SHARPENER. 
We miss both–as does the entire industry. We also want to thank both John and Thomas Knoll for creating 
Photoshop in the first place (otherwise we couldn’t develop plug-ins). Thanks guys!


